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Legal Notices

Warranty
The only warranties for Hewlett Packard Enterprise Development LP products and services are set forth in the express 

warranty statements accompanying such products and services. Nothing herein should be construed as constituting an 

additional warranty. HPE shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HPE required for possession, use or copying. Consistent with FAR 12.211 

and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items 

are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 2016 Hewlett Packard Enterprise Development LP

Disclaimer
Certain versions of software and/or documents (“Material”) accessible here may contain branding from Hewlett-Packard 

Company (now HP Inc.) and Hewlett Packard Enterprise Company.  As of September 1, 2017, the Material is now offered by 

Micro Focus, a separately owned and operated company.  Any reference to the HP and Hewlett Packard Enterprise/HPE marks 

is historical in nature, and the HP and Hewlett Packard Enterprise/HPE marks are the property of their respective owners.

Trademark Notices
Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.

 l Document Release Date, which changes each time the document is updated.

 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:           

https://softwaresupport.hpe.com. 

This site requires that you register for an HPE Passport and sign in. To register for an HPE Passport ID, go to 

https://softwaresupport.hpe.com and click Register. 

Support
Visit the HPE Software Support Online web site at: https://softwaresupport.hpe.com

Release Notes
HPE Project and Portfolio Management

HPE Project and Portfolio Management (9.40) Page 2 of 58

https://softwaresupport.hpe.com/
https://softwaresupport.hpe.com/
https://softwaresupport.hpe.com/


This web site provides contact information and details about the products, services, and support that HPE Software offers.

HPE Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access 

interactive technical support tools needed to manage your business. As a valued support customer, you can benefit by using 

the support web site to:

 l Search for knowledge documents of interest

 l Submit and track support cases and enhancement requests

 l Download software patches

 l Manage support contracts

 l Look up HPE support contacts

 l Review information about available services

 l Enter into discussions with other software customers

 l Research and register for software training

Most of the support areas require that you register as an HPE Passport user and sign in. Many also require a support 

contract. To register for an HPE Passport ID,  go to: https://softwaresupport.hpe.com and click Register. 

To find more information about access levels, go to: https://softwaresupport.hpe.com/web/softwaresupport/access-levels.

HPE Software Solutions & Integrations and Best Practices
Visit HPE Software Solutions Now at https://softwaresupport.hpe.com/km/KM01702710 to explore how the 

products in the HPE Software catalog work together, exchange information, and solve business needs.

Visit Hewlett Packard Enterprise Self-Solve Knowledge Search at 

https://softwaresupport.hpe.com/group/softwaresupport to access a wide variety of best practice documents and materials.
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Installation Notes
Before you install PPM version 9.40, make sure that your system meets the minimum 
requirements, as described in the System Requirements and Compatibility Matrix.

For information about fresh installation of PPM 9.40, see the Installation and Administration 
Guide.

For information about upgrade to PPM 9.40, see the Upgrade Guide.

Documentation for PPM Version 9.40
All documentation for PPM version 9.40 can be found in the product as well as at the HPE 
Software Product Manuals site at the following URL:

(https://softwaresupport.hpe.com/group/softwaresupport).

All of the documentation is available in both Adobe Acrobat (.pdf) format and the majority of the 
documentation is available in online help format.

You can also access PPM documentation through the links provided under topic areas of your 
interest on the PPM Help Center page (Help > Help Center). 
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What's New in PPM 9.40
New Features
PPM 9.40 introduced the following new features:

 l Enhanced Program Management

Program Management is enhanced in the following aspects for program managers and PMOs 
to better govern and execute programs created for various business objectives in the 
organization:

 l Program type

Upon the creation of a program, it is associated with a program type where the program 
settings are inherited. Using program types, PMOs can govern the program template for 
different types of programs to ensure the organization applies standardized format to 
execute programs. Program types also simplifies the mass update of program settings.

To create a program type, select Create > Administrative > Program Type. 

To search a program type, select Search > Administrative > Program Types.

Note: If you upgrade PPM from 9.3x to 9.40, your programs are assigned the out-of-
the-box program type "Enterprise". If you want to change the program type, contact 
Support for help.

 l Program-level request and workflow

PPM 9.40 introduced the following out-of-the-box entities for Program Management: 
Program Details (request type), PFM Program (field group), and Program Process 
(workflow). With these entities, you can customize more information on the program level 
and control the program lifecycle using the request workflow.

The request type (along with the request workflow) linked with a program is specified by the 
Program process Request Type field. The value of this field is inherited from the program 
type the program belongs to, and cannot be changed in the program settings.

Program-level request details are displayed in the Details tab of Program Overview page.

 l Program health tracking

When tracking program health is enabled for a program, PPM calculates the program health 
based on program issues, risks, and scope changes. 

When PPM calculates program health and overriding program's calculated health is enabled, 
program managers are allowed to override the calculated health, select another health for 
the program, and keep the program in the health status for a specified duration.

To enable tracking program overall health, select Track program health for this program in 
program settings. 
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To enable overriding program's calculated health, select Allow program managers to 
override the program's calculated health in program settings.

 l Summarized program header

Program header facilitates you to view the following information in a glance:

 o Program status, associated portfolio, duration and progress

 o Program overall health, issue health, risk health, and scope change health

 o Program budget and actual cost

 l Program milestones

The Timeline tab of Program Overview page enables you to:

 o View the program milestones and milestones of projects included in the program.

 o Monitor milestone status

 o Add and edit program milestones.

 l Program cost

The Cost tab of Program Overview page provides a central location for you to view program 
cost, view program content cost, and perform Earned Value Analysis for projects included in 
the program.

 l User Management Console

User Management Console enables you to search, view, edit, and add users from PPM Web 
pages, saving you the effort to navigate to the PPM Workbench.

To open User Management Console, select Open > Administrative > Open User Management 
Console.

 l PPM-AGM integration using Agile Manager Connector 2

PPM 9.40 uses Agile Manager Connector 2 for the integration between PPM and Agile 
Manager. Agile Manager Connector 2 implements the following advantages:

For the integration between PPM tasks and Agile Manager:

 l You can map a PPM task with a new Agile Manager release, in addition to an existing Agile 
Manager release.

 l You can select a specific sprint of a release to synchronize, and decide the level of details to 
synchronize (release level, sprint level, or user story level).

 l When a PPM project is set as a hybrid project, you can still use time management to track 
actuals against the project as long as time is tracked at task level.

 l When a PPM project is set as a hybrid project, you can still track estimated remaining effort 
per resource assignment.

For the integration between PPM time sheets and Agile Manager:

 l If a sprint in Agile Manager does not fall into the PPM time sheet period, instead of the 
whole sprint efforts are not retrieved into PPM, the efforts in the working days that are 
within the time sheet period are retrieved into PPM.

Release Notes
What's New in PPM 9.40

HPE Project and Portfolio Management (9.40) Page 7 of 58



 l PPM time sheet line cells are filled with daily total effort of all returned tasks in a release, 
instead of the average of total efforts of all returned tasks in a release.

Enhancements
PPM 9.40 includes the following enhancements:

Resource Management

CR Summary

QCCR1L59318 Committing selected resource in resource finder

In previous versions, when you assign a resource to a position, the 
resource status is soft-booked. In this version, you can choose to commit 
assigned resource, that is, when a resource is assigned, the resource 
status becomes committed automatically.

Distributing demand to selected resources evenly in resource finder

In previous versions, when you assign resources to a position, PPM 
allocates the position demand unevenly. It uses up the remaining capacity 
of the first resource, then the second resource, and goes on until demand 
is fulfilled. Starting from 9.32.0003, you can distribute demand to the 
selected resources evenly.

QCCR1L57692 Viewing resource pool assignable resources when Forwarding 
Requests

As a resource manager, you can check the resource availability of any 
resource pool when forwarding requests. This helps makes sure that you 
forward requests to effective resource pools that have assignable 
resources.

QCCR1L59269 Able to select all resources in resource finder

The Check All option is available in the resource finder for you to select all 
resources by one click.

QCCR1L58412 Not sending resource requests for positions of Certain statuses

Resource requests for the following positions are not sent any longer:

 l Requested positions

 l Fulfilled positions

 l Softbooked or new positions that have zero unmet demand
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QCCR1L58748 Hiding staffing profile user data field names in Staffing Profile New 
UI

Staffing profile user data field name can be hidden.

When the description of the user data field is started with "!", the user data 
field name is the value behind the "!".

Therefore, to hide a staffing profile user data field name, set the field 
description to "!" only.

QCCR1L57611 Enhancements on specifying requested resources for positions

 l The Specific Resources Requested column becomes a default column 
in staffing profile.

 l You can specify requested resources in inline-edit mode.

QCCR1L58155 Adding horizontal and vertical totals in Staffing Profile New UI

Horizontal total (Forecast Total and Unmet Total) and vertical totals 
(Total Hours, Average FTE, or Person Days, depending on display view) 
are added in Staffing Profile New UI.

QCCR1L58693
QCCR1L59695

Displaying resource remaining capacity

Resource remaining capacity is displayed in Staffing Profile New UI and 
Resource Allocation Management Gantt view.

QCCR1L59251 Filtering positions by unmet demand and over-allocation in Staffing 
Profile New UI

You are able to filter positions by unmet demand and over-allocation in 
Staffing Profile New UI, as you do in Staffing Profile Legacy UI.

QCCR1L59284 Easier way to enter efforts for positions

In the Table view of Staffing Profile New UI, you can use SHIFT + CLICK 
to copy and paste efforts for positions in the same row.

Project Management

CR Summary
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QCCR1L57425 More options in Staffing tab of Project Overview Page

The following options are added in the Staffing tab of Project Overview 
page to facilitate the use of staffing profile in this tab:

 l Change Header or View Header button, depending on your access 
grant.

 l More button, which enables you to configure access, configure 
notifications, delete staffing profile, and view staffing profile audit trail.

 l Export to Excel icon.

Platform

CR Summary

QCCR1L59947 Tracking user sessions using database table

Using the table PPM_LOGON_SESSIONS, you can track user sessions, 
including session start and end time, session type, how users logged on to 
PPM, PPM node on which the session was created, and how the session 
ended.

QCCR1L60348 Exporting table component fields and requests search result to xlsx 
format

Table component fields and request search result are now exported to 
real Excel file (xlsx file) instead of xls file.

QCCR1L60749 Enabling PPM Workbench to communicate with PPM Server via 
HTTPS

In 9.40, PPM workbench will communicate with PPM Server using HTTPS 
instead of RMIS by default.

If you still want PPM Workbench to communicate with PPM Server via 
RMIS, set the parameter ENABLE_WORKBENCH_HTTP is set to false.
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QCCR1L57430 Preventing Data Loss Due to Inactivity in Request Details, Project 
Details, and Edit Time Sheet pages

You might spend long time entering data in pages like Edit Time Sheet 
page and Project Details page. However, PPM would regard this as 
inactivity and then terminate your session. This causes inconvenience 
because you have to start all over again. 

PPM now introduces two parameters (REQUEST_AND_PROJECT_ 
KEEPALIVE_MAX_IDLE_TIME and TIMESHEET_KEEPALIVE_MAX_ IDLE_TIME) 
for you to specify the duration you can stay idle in the Request Details 
page, Project Details page, and Edit Time Sheet page. This helps prevent 
data loss because of inactivity in these pages.

Certifications
PPM 9.40 includes the following certifications:

 l Support for OpenJDK 8

 l For Windows platform, only Azul Zulu (a certified build of OpenJDK 8 ) is supported.

 l For Linux platform, only OpenJDK 8 built into Linux distributions is supported.

 l Support for Red Hat Enterprise Linux 7

 l Mozilla Firefox support is extended to 45.0 ESR

 l Google Chrome support is extended to 47

 l Remove support of Internet Explorer 10

For more details, see the System Requirements and Compatibility Matrix for version 9.40.
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Fixes
Admin Tools

CR Problem Solution

QCCR1L57155 If a day is not only the first day of daylight 
saving time of the year, but also the end date of 
a week and the end date of a month, generating 
fiscal periods including that day reports errors.

Generating fiscal periods 
reports no errors no 
matter whether or not it 
contains daylight saving 
time days.

QCCR1L59605 In IE 11, the DMS configuration page is covered 
by blank space.

In IE 11, the DMS 
configuration page is 
displayed correctly

QCCR1L59604 In IE 11, multiple scroll bars appear in the 
Administration Console License page.

In IE 11, only one scroll 
bar appears in the 
Administration Console 
License page.

QCCR1L59607 In IE 11, the Application Configuration page 
layout issues make it hard to use.

In IE 11, the Application 
configuration page is 
displayed normally.

QCCR1L59667 In IE 11, the Browse PPM Server files page in 
the Administration Console is displayed badly.

In IE 11, the Browse PPM 
Server files page in the 
Administration Console is 
displayed correctly.

Costing
CR Problem Solution

QCCR1L58639 The resource forecast cost graph in the Cost 
tab of a project still shows value when all the 
positions of the project staffing profile are 
removed.

When all the positions of a 
project staffing profile are 
removed, the resource 
forecast cost graph shows no 
value.

QCCR1L58842 The format of the Project Cost Details report 
is corrupted when there is some data in the 
report. If there is no data, the layout is 
correct.

The Project Cost Details 
report is always formatted 
correctly no matter whether 
there is data in the report.
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QCCR1L59350 Cost Rollup service is running nonstop 
without getting completed.

The performance issue with 
the Cost Rollup service is 
improved.

QCCR1L59525 The Cost Rollup service should sort the 
pending records in ascending order of the 
creation date and handle the earliest 
pending record first.

The Cost Rollup service now 
processes the earliest 
pending record first.

QCCR1L59669 In IE11, the input fields in the following 
pages are compressed and almost on top of 
each other:

-- Analyze Current Cost Metrics for Projects
-- Search Cost Rules
-- Create Activity
-- Create a New Region

In IE11, the input fields in 
these pages are displayed 
correctly with appropriate 
space between each other.

QCCR1L59722 FX Rate Update Service should skip 
duplicated financial summary lines and 
handle data in batches.

FX Rate Update Service skips 
duplicated entities and 
commit updates one by one.

QCCR1L59877 The table header height of the Edit Cost 
page is too large in IE 11.

The table header height of 
the Edit Cost page is reduced 
to be normal in IE 11.

QCCR1L59878 In the Edit Cost page, if you click the space 
near the edit icon, the Edit a Cost Line 
window still pops up but the Category field is 
blank.

In the Edit Cost page, clicking 
the space around the edit 
icon does not open the Edit a 
Cost Line window.

QCCR1L60209 The Project Cost Detail report prints the 
same project record for multiple times.

The Project Cost Detail 
report prints the same project 
record only once

QCCR1L60245 If while the FX Rate Update service is 
running, you delete a project and financial 
summary, the service will fail stating that 
"Object cannot be found" and will stop 
running.

FX Rate Update service skips 
the entities that have already 
been deleted.

Dashboard
CR Problem Solution
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QCCR1L59188 Filter fields within portlets are not 
working if 'WHERE clause' contains 
'rownum=x'. Once the rownum clause 
is removed, the portlet works as 
expected.

Filter fields whose 'WHERE clause' 
contains 'rownum=x' now work as 
expected.

QCCR1L59658 In IE11, if you click Find Portlets 
button in the Personalize Dashboard 
page, the table is displayed badly with 
the rows oversized.

In IE 11, the table in the Find Portlet 
window is displayed correctly.

QCCR1L59820 Suppose you use a bar chart portlet 
to group requests by a parameter 
containing a date value. When you 
drill down on one of the bars, no rows 
are retrieved.

Drill-to portlet of a bar chart portlet 
that groups requests by a date field 
returns correct records.

QCCR1L59862 In the pop-up window of an ACL 
field, the size of the Available column 
is bigger than that of the Selected 
column.

In the pop-up window of the ACL 
field, the size of the Available 
column is equal to that of the 
Selected column.

QCCR1L60275 When the URL field value in a portlet 
contains space and you export the 
portlet to Excel, the Excel file is 
empty.

When the URL field value in a portlet 
contains space, exporting the portlet 
to Excel is successful.

QCCR1L61632 It takes long to open a dashboard 
page that contains 7 or 8 portlets.

The time it takes to open a 
Dashboard page is decreased.

QCCR1L62122 Chart portlets cannot be displayed 
because of the error "Could not 
initializeclas 
ilog.views.util.swing.IlvSwingUtil".

Chart portlets can be displayed 
correctly.

QCCR1L58978 Custom bar chart portlets with only 
one bar and no portlet title are 
displayed incorrectly.

Custom bar chart portlets are always 
displayed correctly regardless of the 
number of bars.

QCCR1L59001 An error message appears when you 
try to add a new column in data 
source and portlet definition and 
then refreshed the portlet.

You can now add a new column in 
data source and portlet definition 
without the error.
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QCCR1L59210 The following error appears when 
you use the Staffing Profile filter in 
the Resource Requests portlet.

"The validation associated with this 
component produced an error. Please 
see details. (KNTA-10199)"

The error no longer appears when 
you use the Staffing Profile filter in 
the Resource Requests portlet.

QCCR1L59424 Unnecessary queries are called when 
you export the Request List portlet 
to Excel.

Only queries that are optimal and 
need to be executed are called when 
you export the Request List portlet 
to Excel.

QCCR1L60741 If a portlet has a column with Link 
validation and you put the portlet in 
the Project Overview page, the link 
column cannot be opened because of 
javascripterror "gotoUrlRefs is not 
defined".

If a portlet has a column with Link 
validation and you put the portlet in 
the Project Overview page, the link 
column can be opened without 
errors.

QCCR1L61300 When exporting a pivot type portlet 
with more than 3 columns by 3 rows 
to Excel, the header that expands 
both columns and rows do not match 
its body columns.

When exporting a pivot type portlet 
with more than 3 columns by 3 rows 
to Excel, the header that expands 
both columns and rows is in the 
correct position covering all its body 
columns.

QCCR1L61519 Exporting pivot portlets to Excel does 
not work in IE 11.

Exporting pivot portlets to Excel 
now works in IE 11.

Demand Management
CR Problem Solution

QCCR1L47264 The "Apply before transition" 
rules do not work when you use 
Mass Update functionality for 
requests.

The "Apply before transition" rules work 
as expected when you use Mass Update 
functionality for requests.
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QCCR1L52844 The transition step name is not 
shown in the graphical view of 
the request from a particular 
execution step. This particular 
execution step uses validation 
with SQL to derive the transition 
name. The transition name from 
that particular execution steps is 
only visible after the step has 
been traversed.

When PPM gets the transition name it 
only gets meaning, but if the transition 
uses a validation with SQL, there's no 
meaning. In this case, PPM uses code as 
the transition name. Therefore, the 
transition step name will be shown in 
the graphical view of the request.

QCCR1L53760 When you print a request, some 
sections are collapsed in the print 
mode even when they are 
expanded in the edit mode.

Requests in the print mode are 
displayed the same as in the edit mode.

QCCR1L57285 When you fill in the mandatory 
request fields, add resources in 
the Resource section, and then 
click an action button, you find 
the other fields are filled but the 
resources are not saved.

Both the filled request fields and the 
added resources are saved when you 
click an action button.

QCCR1L57752 When more than one user 
updates a request, the following 
error message appears:

"This Request has been updated 
by another user. Please refresh 
the Request and then continue 
with your changes. (KCRT-
40134)" 

But after clicking the refresh link, 
it throw another error "The page 
you requested does not exist." 

The refresh link now correctly points to 
the request page and will refresh it.
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QCCR1L57863 The getRequest Web service 
cannot return the Attachments 
field in the request details 
section.

The getRequest Web service can now 
return the Attachments field in the 
request details section, as follows:

<simpleFields>    
<common:token>REQD.VP.<
tokenname>     
</common:token>;     
<stringValue>documentName=  
<filename>;      
description=<description>    
</stringValue> </simpleFields>

QCCR1L57864 The getRequests Web service 
returns empty value for the 
description of the attachments 
field in the request reference 
section.

The getRequest Web service returns the 
correct value for the description of the 
attachments field in the request 
reference section.

QCCR1L59076 When you create a request using 
the save draft functionality, the 
resources assigned to the 
request disappear.

Resources are retained for the requests 
created using the save draft 
functionality.

QCCR1L59151 When you export the Request 
List portlet to Excel, not all the 
information of the portlet is 
exported.

When you export the Request List 
portlet to Excel, all the information of 
the portlet is exported.

QCCR1L59314 Opening proposals for some 
users is very slow.

The performance of opening proposals 
is improved.
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QCCR1L59352 When a request begins loading, 
the workflow action buttons are 
immediately displayed and 
available to be clicked. But if you 
click an action button while the 
request is not completely loaded, 
the button stops responding. 
Therefore, workflow action 
buttons should be clickable and 
usable when the page is not fully 
loaded or the action buttons 
should be made unclickable until 
the page is fully loaded.

Workflow action buttons cannot be 
clicked until the page is fully loaded.

QCCR1L59455 In a customized table component 
field, users can manually enter 
the value with "$" followed by 
space and then a number. The 
system allows saving the value 
without prompting users that the 
format is incorrect but converts 
the value to another format (for 
example, "$ 100" is converted to 
"$,100.00"). This results in the 
distorted layout of the page.

If there is space between the currency 
symbol and the number, the system 
removes the space automatically.

QCCR1L59660 In IE 11, the scroll bars in all the 
multi-select Auto Complete List 
dialogs are not visible unless the 
selection requires it.

The scroll bars in multi-select Auto 
Complete List dialogs are available in 
IE11, like in lower versions of IE 
browser, for example IE 9.

QCCR1L59778 When there is a table component 
field in a request, "Unsaved filed" 
warning message prompt is 
displayed even when no changes 
are made.

The warning message no longer pops 
up when no changes are made to a 
request.

QCCR1L60131 Exporting Request List portlet to 
Excel fails when there are 
hyperlinks in any columns.

Exporting Request List portlet to Excel 
works fine when there are hyperlinks in 
any columns.
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QCCR1L60525 When you export the Request 
List portlet with empty columns 
to Excel, the empty columns are 
not displayed as blank cells in 
Excel.

When you export the Request List 
portlet with empty columns to Excel, the 
empty columns are now displayed as 
blank cells in Excel.

QCCR1L60708 Scroll bar in ACL dialog is not 
working for Hierarchical view of 
ACL fields under IE standard 
mode.

Scroll bar in ACL dialog can be scrolled 
up and down well for Hierarchical view 
of ACL fields under IE standard mode.

QCCR1L60943 When you add a row to a table 
component field, click Save, and 
then quickly double-click a 
workflow action button, 
duplicate table component rows 
are created.

When you add a row to a table 
component field, double-clicking a 
workflow button will not create 
duplicate table component rows.

QCCR1L61537 When you create a new request 
from references section and 
when the request types of child 
request and parent request are 
different, table component of the 
child request does not retain 
values in table component of the 
parent request. 

When you create a new request from 
references section and when the 
request types of child request and 
parent request are different, table 
component of the child request retains 
values in table component of the parent 
request.

QCCR1L61753 Table Component stops working 
when a drop-down list value that 
is in use is disabled.

Disabled values in the drop-down list do 
not prevent table component from 
working.

QCCR1L61865 Errors occur when using the 
getRequests web service.

The errors no longer occur when using 
the getRequest web service.

QCCR1L62439 When the project details or 
request details page is not 
maximized, the buttons in the 
upper-right corner (Save, More, 
and Copy) are moved to the 
second line if there are many 
workflow action buttons.

The Save, More, and Copy buttons 
stays in the first line when there are 
many workflow action buttons.
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Deployment Management
CR Problem Solution

QCCR1L57101 Release Detail Report is failing with the 
following error: 

"Error: ORA-00904: "PM"."UTILS"."GET_
PROJECT_RESOURCE_LIST": invalid 
identifier{KNTA_REPORT-3000}"

The Release Detail Report now 
runs successfully without the 
error.

QCCR1L60142 Error messages appear when you migrate 
request types.

The errors no longer appear 
when you migrate request 
types.

QCCR1L60593 Unable to migrate dashboard entities 
such as modules and portlet definitions, 
because these dashboard entity IDs are 
longer than the maximum Java integer 
(2147483647).

PPM now treats dashboard 
entity IDs as long values instead 
of integers.

Documentation
CR Problem Solution

QCCR1L58861 The server configuration 
parameters SERVER_LOCALE_
COUNTRY_CODE and SERVER_
LOCALE_LANGUAGE_CODE are 
mandatory, or the notification 
emails will not be sent to the 
external email addresses.

Added the following in the document:

The parameters SERVER_LOCALE_
COUNTRY_CODE and SERVER_
LOCALE_LANGUAGE_CODE should 
not be null, or email notifications 
cannot be sent to external email 
addresses.

QCCR1L58378 At most 20 items can be added to 
the Personalized Dashboard page. 
This limitation should be added to 
PPM guides.

Add the following note in the Getting 
Started guide:

You can add no more than 20 items 
(pages or groups) in the Private pages 
folder of the Personalized Dashboard 
page. It is recommended that you 
group some pages if you exceed the 
limit and still want to add items.
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QCCR1L61993 In Installation and Administration 
guide, the description of parameter 
PORTLET_MONITOR_PERSIST_
STATE is not correct.

Update the description of the 
parameter as follows:

If the parameter PORTLET_
MONITOR_PERSIST_STATE is set to 
true, portlet monitor logs portlet load 
information in the table PPM_
PERFORMANCE_LOG.

QCCR1L59453 The RESTful Web service 
getRequests returns at most 
10000 requests of a certain type. 
This limitation is not included in 
PPM guides.

Add the limitation in the Getting 
Requests of a Certain Type section of 
the RESTful Web Services guide.

QCCR1L61487 The document about DMS_
INSECURE_FILE_EXTENSION_
CHECK and DMS_INSECURE_
FILE_EXTENSIONS is misleading. It 
gives users an impression that only 
executable file extensions can be 
added to parameter DMS_
INSECURE_FILE_EXTENSIONS, 
but actually any file extensions can 
be added to DMS_INSECURE_
FILE_EXTENSIONS.

Update the descriptions of DMS_
INSECURE_FILE_EXTENSION_
CHECKand DMS_INSECURE_FILE_
EXTENSIONS in the  Installation and 
Administration Guide and Document 
Management Guide and Reference.

For details, see "Incorrect description 
of  DMS_INSECURE_FILE_
EXTENSION_CHECK and DMS_
INSECURE_FILE_EXTENSIONS" on 
page 57.

QCCR1L59171 The Installation and 
Administration Guide states the 
following: 

"On the License Install page, click 
Browse to locate the license file 
you saved, and then click Submit. 
The license file is installed and 
becomes effective right away, with 
a message popping up showing 
how many licenses are installed."

However, in fact there is only an 
Install button instead of a Submit 
button.

Correct the button name in the 
Installation and Administration Guide .
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QCCR1L59885 The below listed tables are newly 
added in 9.3 but are not in the 
entity relationship diagram.

RSC_SIMPLE_ASK_EFFORTS
PPM_FM_COST_SNAP_SHOT
PPM_FM_COST_AUDIT
PPM_FM_COST_AUDIT_RATE
PPM_FM_PLAN_VALUE

Staffing Profiles diagram is updated in 
the Data Model Guide for version 9.40.

QCCR1L61995 Oracle 12 Known issue should be 
documented in the Installation and 
Administration Guide or the 
Upgrade Guide.

Added the workaround for Oracle 12 
known issue in the support matrix 
guide.

Integrations
CR Problem Solution

QCCR1L59515 PPM notes format is broken when 
the notes are sent to ALM.

PPM keeps notes format when 
sending notes to ALM.

QCCR1L59591 After the synchronizing from MSP 
to PPM , the values of the columns 
EARNED_VALUE_BSE and 
PLANNED_VALUE_BSE of the table 
WP_TASK_COSTS are null.

The values of the columns EARNED_
VALUE_BSE and PLANNED_VALUE_
BSE of the table WP_TASK_COSTS 
are not reset after the 
synchronization from MSP to PPM.

QCCR1L59864 In IE 11, there are blank lines 
between table title and table rows in 
Manage Application Change and 
View Project Quality tabs of the 
Integration Configurations page.

In IE 11, the blank lines between the 
table title and table rows disappear in 
these two tabs of the Integration 
Configurations page.

QCCR1L60272 In the Broker In Use Sessions report, 
some DB sessions persist for more 
than 2 days.

The DB sessions are closed after SQL 
execution.

QCCR1L61457 When trying to download an 
attachment from ALM in PPM, the 
downloaded file is empty. This 
happens only for attachments where 
the file name contains space.

You can now download ALM 
attachments in PPM when the file 
name contains space.
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Platform
CR Problem Solution

QCCR1L56759 When you are in Spanish session, the 
following strings in the Cost tab of 
project are still in English:

 l Warnings in the Earned Value 
Analysis

 l "Click to view more months" in 
Financial Summary

These strings are translated into 
Spanish.

QCCR1L57072 An error appears when a parameter 
field for a report has more than 200 
characters.

The error disappears because PPM 
increases the character string buffer 
from 200 to 4000 for parameter 
fields.

QCCR1L57149 Excel reports do not work in French 
language session.

Updated the Excel Reports 
Cookbook to explain the scenario 
where you use more than one 
language in PPM instance.

QCCR1L57170 The portlet monitor is still active 
after setting the following 
parameters to false.

 l ENABLE_ALL_PERFORMANCE_
MONITOR

 l ENABLE_PORTLET_MONITOR

The portlet monitor is disabled when 
you set the following parameters to 
false:

 l ENABLE_ALL_PERFORMANCE_
MONITOR

 l ENABLE_PORTLET_MONITOR

QCCR1L57444 An SQL exception appears when 
installing PPM 9.31.

The exception disappears by 
increasing the length of Version 
column in KNTA_ARCHIVES table.

QCCR1L58199 The index KNTA_REPORT_
SUBMISSIONS_N1 needs to be 
changed to address the performance 
issue with submitting reports.

Added the CREATED_BY column in 
the KNTA_REPORT_SUBMISSIONS_
N1 index, and the performance issue 
with submitting reports is solved.

QCCR1L58206 Date and link validation fields are not 
working in table component fields in 
Chrome.

n/a
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QCCR1L58895 In the Project Exceptions tab of 
Project Overview page, the 
Portuguese translations of SPI and 
CPI are swapped.

The Portuguese translations of SPI 
and CPI in Project Exceptions tab 
have been corrected.

QCCR1L58904 You cannot search @Request_ID in 
the quick search box in the top right 
corner of the staffing profile Gantt 
view, Resource Allocation 
Management page, and work plan 
Quick view. Debug Console is not 
enabled in the Staffing Profile page, 
Resource Allocation Management 
page, Integration Center, and work 
plan.

You can now search @Request_ID in 
the quick search box in the staffing 
profile Gantt view, Resource 
Allocation Management page, and 
work plan Quick view. Debug 
Console can be enabled in the 
Staffing Profile page, Resource 
Allocation Management page, 
Integration Center, and work plan.

QCCR1L59221 The standard tokens [RP.REPORT_
LOG_URL] and [AS.BASE_URL] 
return different results, which makes 
report links inaccessible. Sometimes 
the links include /itg/ part and 
sometime they don't.

The standard tokens [RP.REPORT_
LOG_URL] and [AS.BASE_URL] 
return consistent results. Report links 
are accessible now.

QCCR1L59254 Blocking sessions issue with the 
ActiveMQ tables occurs during the 
peak load period.

Missing indexes are added to fix the 
performance issue:

 l The PPM_FISCAL_PERIODS_
NLS_N2 index (with the columns 
PERIOD_TYPE,START_DATE, 
END_DATE, and FISCAL_
PERIOD_ID) is added for the 
PPM_FISCAL_PERIODS_NLS 
table.

 l The RSC_POSITION_FORECAST_
N7 index (with the columns 
POSITION_ID,UNMET_DEMAND, 
and FORECAST_DATE) is added 
for the RSC_POSITION_
FORECAST table.
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QCCR1L59264 The option Open > Administrative > 
Open Workbench does not work in 
Chrome.

This issue is due to NPAPI 
deprecation. You can open PPM 
Workbench in Chrome by clicking 
Open > Administrative > Open 
Workbench on Desktop or use 
Internet Explorer.

QCCR1L59315 kStart.sh causes stability issue when 
ulimit values are too low.

The default ulimit values in kStart.sh 
has been changed as follows:

 l ulimit -n is changed to 4096

 l ulimit -u is changed to 20000

If the ulimit values in kStart.sh do not 
take effect, you should set bigger 
limitations in OS settings.

QCCR1L59394 When you run the Import Users 
report to import resources from the 
RSC_RESOURCES_INT table, the 
resource roles are not updated 
completely. The report only updates 
the roles in the RSC_RESOURCES 
table. The roles in the RSC_
RESOURCE_ROLES table are not 
updated. It results in the wrong data 
when you export search resource 
page to Excel.

Resource roles in both the RSC_
RESOURCES table and the RSC_
RESOURCE_ROLES table are 
updated when you run the Import 
Users report.

QCCR1L59499 In cluster configuration 
environment, the CPU load of one 
node stays high and becomes 
increasingly high.

The CPU load of the node is normal 
now.

QCCR1L59532 Notifications cannot be sent to 
multiple email addresses which are 
separated by semicolons (;).

Notifications can now be sent to 
multiple email addresses which are 
separated by semicolons. Invalid 
email addresses are skipped.
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QCCR1L59563 Suppose you have a validation 
(component type: auto-complete list 
with SQLqueries, using the 
[TSK.TASK_ID] token), and create a 
user data field with the validation. 
When you click the field in the work 
plan Quick view, you get the 
following error:

"One of the tokens in the validation 
was unparseable. This can be caused 
by aninvalid token name or missing 
data from the field the token 
represents.(KNTA-10073)"

The error no longer appears when 
you click a user data field that uses 
such validations in work plan Quick 
view.

QCCR1L59574 If you use BusinessObject on PPM, 
extra steps should be performed 
when using the PPM Purging Tool.

Add the following steps in the Purge 
Stale Data Using the PPM Purge 
Tool section of the Installation and 
Administration guide:

Step 2: (Required if you 
useBusinessObject on PPM) Stop 
the capture process of Oracle 
Streams.

Step 23:(Required if you use 
BusinessObject on PPM) After the 
purging is done, perform afull ETL.

QCCR1L59664 If you have DebugFilter enabled, an 
unknown error appears when you 
log on to PPM.

The error no longer appears when 
you log on to PPM with DebugFilter 
enabled.

QCCR1L59786 Clicking a staffing profile link in the 
Request List portlet points to the 
next staffing profile in the list.

Clicking a staffing profile link in the 
Request List portlet points to the 
correct staffing profile.

QCCR1L59972 Several request send multiple email 
notification (50-100 at different time 
intervals) after the upgrade to PPM 
9.31.

This issue occurs because the default 
language and country code are null. 
Email notifications are not sent 
repeatedly as PPM sets the default 
language and country code to en/US.

QCCR1L60071 After the upgrade to 9.31, there is a 
substantial increase in logging 
activities in the thresholdLog.txt file.

The thresholdLog.txt file now only 
contains the information that meets 
the predefined threshold.
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QCCR1L60590 If you click 4 px above or below a 
menu label, the menu closes without 
opening any page.

When you click a menu label, as long 
as it is highlighted, it takes you to 
where it should.

QCCR1L60700 When you add a predecessor for a 
task, with the predecessor being a 
task from another project, an error 
occurs.

When you add a predecessor for a 
task, with the predecessor being a 
task from another project, the error 
no longer occurs.

QCCR1L60827 When a custom pivot portlet is 
added to the dashboard page, an 
pop-up window opens asking for 
credentials under SSO environment.

Adding custom pivot portlets to the 
dashboard page does not ask for 
credentials.

QCCR1L61112 When the project is created using 
ksc_create_project, the REF_
RELATIONSHIP_ID is 16, but when 
a request, from which the project 
gets created, is saved after creation, 
the REF_RELATIONSHIP_ID is 
getting changed to 400.

REF_RELATIONSHIP_ID is correct 
when you create project using ksc_
create_project.

QCCR1L61447 On the Stafing Profile resource 
assignment dialog box the word 
"dotted" was translated to 
"pontulhada". The correct spelling is 
"pontilhada".

"pontulhada" is updated to 
"pontilhada"

QCCR1L61898 There are exceptions about the Cost 
Rate Rule Update Service (while the 
Cost Rate Rule Update service 
attempts to recalculate a staffing 
profile that has been already 
deleted). Cost rate rule update 
service should ignore the invalid 
pending entities.

Cost rate rule update service ignores 
the invalid pending entities.

Portfolio Management
CR Problem Solution
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QCCR1L59211 The "Last Updated by" and "Last 
Updated on" values are changed in 
scenario comparison when you only 
change the Graph Period Interval 
value.

The "Last Updated by" and "Last 
Updated on" values are not changed 
in scenario comparison when you 
only change the Graph Period 
Interval value.

QCCR1L59763 View Portfolio page is not rendered 
correctly in IE 11

The View Portfolio page is displayed 
correctly in IE 11

QCCR1L59750 The Scenario Comparison page is 
not rendered correctly in IE 11.

The Scenario Comparison page is 
displayed correctly in IE 11.

Project Management
CR Problem Solution

QCCR1L53058 When opening a project risk from the 
Project Overview page, it opens in 
the same browser page. When 
opening a project issue from the 
Project Overview page, it opens in a 
new window. Opening a project issue 
and opening a project risk from the 
Project Overview page should 
behave the same.

When you open a project issue from 
the Project Overview page, it now 
opens in the same browser page.

QCCR1L55353 In work plan Gantt view, when you 
click Zoom Gantt Out twice, the 
timeline of the project is wrong 
although the tooltip shows the 
correct scheduled start and finish 
dates. This happens only in Swedish 
regional settings.

In Swedish regional settings, the 
timeline of the project displays 
correct project duration when you 
click Zoom Gantt Out twice in work 
plan Gantt view.

QCCR1L59063 When using the Activity column in a 
project work plan, if you enter a 
value andcpress Enter, the value is 
copied to the rows below, and if you 
then click Save, the original value is 
deleted and the copied value is 
saved.

When using the Activity column in a 
project work plan, if you enter a value 
and press Enter, the value will be 
saved to the current row successfully.

Release Notes
Fixes

HPE Project and Portfolio Management (9.40) Page 28 of 58



QCCR1L59111 A line in the Project Cost portlet of 
the Project Summary page gets 
interrupted.

The layout issue of Project Cost 
portlet in the Project Summary page 
no longer appears.

QCCR1L59139 The error "java.sql.SQLException: 
ORA-01489: result of string 
concatenation istoo long" occurs 
when you view the Project List 
portlet.

This error no longer occurs when you 
view the Project List portlet, because 
when the Project Manager field 
contains more than 4,000 characters, 
PPM truncates the exceeded 
characters in the tooltip.

QCCR1L59490 In IE 11, you cannot resize work plan 
columns because mouse cursor 
cannot be located in some areas of 
the column delimiters.

You can now resize work plan 
columns wherever you put the cursor 
on the column delimiter in IE 11.

QCCR1L59867 In IE11, in the Task Detail page, the 
input boxes in the Resources tab are 
not in the same line.

In IE11, in the Task Detail page, the 
input boxes in the Resources tab are 
now in the same line.

QCCR1L59880 It takes long to close the project 
settings page after you click Done.

A new server.conf parameter ENABLE_
SP_LABOR_COST_UPDATE is added to 
fix this issue. 

This parameter controls whether 
PPM calculates staffing profile labor 
cost when you save project settings. 
By default, it is set to true. And PPM 
suggests that you do not change the 
default setting. If you find saving 
project settings takes longer than 
you expect, you can set the 
parameter to false.

QCCR1L60521 PPM should keep the original 
budget value in DB instead of 
rounded-up value.

Original approved budget will not be 
truncated to integer automatically 
and PPM keeps the original budget 
value in DB.

QCCR1L60905 The exception 
"AuthorizationException" occurs 
when Integration SDK Sync serviceis 
running.

The exception no longer occurs when 
the service is running.
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QCCR1L61125 For projects that use a different 
currency than base currency, the 
currency symbol and currency value 
in the tooltips for the graph in 
Resource Forecast Cost under 
project Cost tab are inconsistent.

The tooltips for the table in Resource 
Forecast Cost under project Cost tab 
display consistent currency symbol 
and currency value.

Resource Management
CR Problem Solution

QCCR1L56946 In Spanish session, Gantt 
Legend for staffing profile is 
not displayed in Spanish.

In Spanish session, Gantt Legend for 
staffing profile is displayed in Spanish.

QCCR1L58416 When you export the Analyze 
Assignment Load portlet to 
Excel, the data in the Excel file is 
inconsistent with that in the 
dashboard page for some users 
whose profile regional settings 
is Dutch (Netherlands).

The data of the Analyze Assignment 
Load portlet in the exported Excel file is 
consistent with that in the dashboard 
page for all users regardless of their 
profile regional settings.

QCCR1L58430 When you access skill search 
from a staffing profile, you 
cannot scroll up/down in a 
hierarchical list.

When you access skill search from a 
staffing profile, you can now scroll 
up/down in a hierarchical list.

QCCR1L58908 After the upgrade to 9.31, 
project managers get access 
error while accessing staffing 
profiles.

Project managers can access staffing 
profiles successfully.

QCCR1L59207 In the Legacy UI or the New UI 
of staffing profile page, when 
you change a position forecast 
demand containing zeros 
without first removing the 
value, the new value entered is 
reverted to the previously 
stored value.

In the Legacy UI and the New UI of 
staffing profile page, you can change a 
position forecast demand without having 
to first remove the old value.
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QCCR1L59390 The Save Scenario pop-up 
window for RMO is not 
displayed correctly in German

The Save Scenario pop-up window for 
RMO is displayed in German correctly.

QCCR1L59423 When you try to update the 
forecast value for the resource 
assigned to a position, the value 
is not updated correctly.

The forecast value for the resource 
assigned to a position can be updated 
correctly.

QCCR1L59471 The Gantt chart in the Resource 
Management Optimization 
window cannot be displayed.

The Gantt chart is displayed in the 
Resource Management Optimization 
window.

QCCR1L59613 When you add a request item in 
a time sheet and add some time 
against it, the Analyze 
Assignment Load portlet 
displays the effort with JS 
errors.

The Analyze Assignment Load portlet 
displays the effort with no JS errors.

QCCR1L59659 In IE 11, when you click the skill 
icon in the Search Resources 
page, the scroll bar is disabled in 
skill hierarchy dialog. This issue 
happens in all skill hierarchy 
dialogs.

In IE 11, when you click the skill icon in the 
Search Resources page, the scroll bar is 
enabled in skill hierarchy dialog.

QCCR1L59668 In IE 11 and Chrome, there is 
white space in the middle of the 
Modify Resource Calendar 
page.

In IE 11 and Chrome, there is no white 
space in the middle of the Modify 
Resource Calendar page.

QCCR1L59662 In IE 11, a small scroll bar is 
visible for each field label in the 
Search Positions page (Open > 
Project Management > Staffing 
Profiles > Manage Forecast).

In IE 11, the fields in the Search Positions 
page do not have scroll bars.

QCCR1L59663 In IE 11, the table lines in the 
pop-up position details window 
get misaligned, which makes it 
impossible to know how each 
resource is allocated.

In IE 11, the table lines in the pop-up 
position details window are aligned.
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QCCR1L59690 Default values of staffing profile 
user data fields are not set when 
you create staffing profile from 
the Staffing tab of the project 
overview page.

User data fields are filled with default 
values when you create staffing profile 
from the Staffing tab of the project 
overview page.

QCCR1L59721 Errors appear intermittently 
when you add time sheet 
delegates.

Adding time sheet delegates works fine 
without the errors.

QCCR1L59875 Some input fields are too close 
to each other in the Resource 
Mass Update page.

Add space between these fields.

QCCR1L60054 When the end date of a staffing 
profile is the last month of PPM 
fiscal period, you cannot update 
period and effort in the weekly 
view.

This issue occurs because the last date 
cannot be found in the weekly view. It is 
beyond PPM fiscal period. Now a message 
will appear asking you to extend PPM 
fiscal period when the issue occurs.

QCCR1L60709 If project managers submit a 
resource request of a position 
without providing any demand 
value for it, resource pool 
managers should be able to 
reject the request, however, 
there is no button to reject the 
request.

Resource request for positions with zero 
demand will not be sent out.

QCCR1L60846 Suppose you set the server 
configuration parameter 
RESOURCE_FINDER_SEARCH_
MAX_USERS to 20. When the 
resource finder finds more than 
19 resources, you get the 
following warning message: 
"The search you are about to 
run is returning 20 results. You 
must provide additional filters 
to limit the size of the result set 
to 19."

Suppose you set the server configuration 
parameter RESOURCE_FINDER_
SEARCH_MAX_USERS to 20. When the 
resource finder finds 20 resources, you 
will see 20 resources in the result. When 
the resource finder finds more than 20 
resources, for example 21, your will see 
the warning message "The search you are 
about to run is returning 21 results. You 
must provide additional filters to limit the 
size of the result set to 20."
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QCCR1L60961 For projects that use a different 
currency than base currency, 
the currency symbol and 
currency value are not 
consistent in the table of 
Resource Forecast Cost under 
project Cost tab.

The table of Resource Forecast Cost 
under project Cost tab displays consistent 
currency symbol and currency value.

QCCR1L61096 When you use staffing profile 
web service to add position 
lines, the web service cannot 
search resource pools whose 
names contain special Turkish 
characters.

Staffing profile web service can search 
resource pools whose names contain 
special Turkish characters.

QCCR1L61173 If you click the "More" link 
multiple times in a short time, 
there will be duplicate resources 
in the result.

When you click the "More" link multiple 
times in a short time, there will be no 
duplicate resources in the result.

QCCR1L61486 Toggle Unmet button in 
Staffing Profile Table View is 
not persistent. It is always 
returning to its default setting 
when you switch back to the 
Table view.

The Toggle Unmet button will not revert 
to its default setting when you switch 
back to the Table view.

QCCR1L62396 Cannot save changes to staffing 
profile notification settings.

Changes to staffing profile notification 
settings are can now be saved.

Time Management
CR Problem Solution

QCCR1L59149 In the time sheet details page, the task 
path below the task name does not 
display the character ">".

The task path in time sheet details 
page now displays the character ">".
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QCCR1L59426 If there is a time sheet with 
unapproved lines (excluding Misc. 
items), and the approver tries to 
approve the time sheet using the bulk 
approval functionality, an error is 
thrown by the system. This is because 
there are time sheet lines that cannot 
be approved by the approver.

Approvers can approve the time 
sheet using the bulk approval 
functionality without the error, and 
the time sheet lines that cannot be 
approved by the approvers are 
unapproved.

QCCR1L59558 The exception "You can not approve 
timesheet" appears when you try to 
use time sheet bulk approval.

The exception no longer occurs 
when you use time sheet bulk 
approval.

QCCR1L59557 A project manager's delegate is not 
able to approve time sheet lines as 
he/she cannot see the option.

Project Manager's delegate can 
approve the time sheet lines.

QCCR1L59740 The elapse time of an out-of-the-box 
time sheet SQL per execution is more 
than 2 hours as per AWR report.

The time sheet search (on both 
search page and portlet) will now 
time out when it exceeds the 
number of seconds defined in the 
server parameter SEARCH_
TIMEOUT.Thisparameter now 
controls the time out of both the 
request search and time sheet 
search.

QCCR1L59847 The last day of a specific week is 
missing in time sheet.

The last day is not missing for the 
week in newly created time sheets.

QCCR1L60026 The updateTimeSheet web service 
automatically fills the "% Complete" 
field with incorrect value.

Using the updateTime Sheet web 
service to update time sheets has 
the same behavior as you update 
time sheets in the web client. If 
"Require resources to enter % 
Complete along with actual effort" 
and "Track Estimated Remaining 
Effort per resource assignment" 
options are not checked in project 
settings, the"% Complete" is not 
updated in time sheets.
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QCCR1L60074 The tooltips in the graphs of the 
Project Cost tab are not consistent 
with the months you put the cursor 
over.

The tooltips now show fiscal month 
short name, start date, and end 
date.

QCCR1L60128 You cannot submit time sheets using 
Mobile Website Client when the time 
entered is equal to the minimum hours 
specified by the time sheet policy. 
However, you can submit time sheets 
in this case in front end.

You can submit time sheets using 
Mobile Website Client when the 
time entered is equal to the 
minimum hours specified by the 
time sheet policy.

QCCR1L60210 When you create time sheets using 
the CreateTimeSheet time web 
service, and then submit them using 
the submitTimeSheet web service, the 
time sheets are in the status of 
pending approval instead of approved 
even though you have enabled 
automatic time approval.

Add code in submitting function to 
judge if a time sheet can be auto-
approved. If yes, it is approved 
automatically.

QCCR1L61151 When you submit an empty note in 
the Notes tab of Time Sheet Line 
Details, the tab is saved as "null".

Empty notes in Time Sheet Line 
Details are saved as empty notes 
instead of "null".
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Known Problems and Limitations
The following problems and limitations are known to exist in PPM version 9.40 (or other software, 
as indicated). The problems are categorized by the affected product area. If a problem has an 
assigned internal tracking number, that tracking number is provided (in parentheses) at the end 
of the problem description.

Admin Tools

Problem: If Windows system language is Chinese, Japanese, or Korean, and the system has JDK 8 
installed, PPM kConfig wizard does not display language list where you can select one for the 
wizard display. (QCCR1L62596)

Workaround: None.

Dashboard

Problem: When a request contains HTML related characters in its request description, the 
request is not displayed in the My Requests portlet. (QCCR1L42543)

Workaround: Make sure not to include any HTML related characters in the description of a 
request.

Problem: Any PPM Center portlets that contain the word “program” do not display the new 
Chinese translation for “program” and instead display the old Chinese translation for “program”. 
(QCCR1L27636)

Workaround: None.

Problem: When the length of a word in a portlet name exceeds 30 characters (without aspace), 
after you click Find Portlets in the Add Portlets window, the Portlet Namecolumn in the resulting 
list is resized automatically, other columns are pushed to theright side, and no horizontal scrollbar 
is available. If the word is really long (say, 100 characters), the buttons in the right side of the 
window may disappear. (QCCR1L41717)

Workaround: Maximize the Add Portlets window.

Demand Management

Limitation: If you use the same token in both the WHERE clause of an ACL validation's SQL 
statement and the SQL statement of the validation's filter field, PPM may return no value for the 
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ACL field when you change the value of the field associated with the token in PPM Web pages. 
(QCCR1L54208)

Workaround:  This is because the value of the token used in the WHERE clause of the ACL 
validation's SQL statement is retrieved from the Web pages, while the value of the token used in 
the SQL statement of the validation's filter field is retrieved from PPM database. 

To avoid this issue, PPM recommends that you not use the same token in the WHERE clause of an 
ACL validation's SQL statement and the SQL statement of the validation's filter field.

Problem: The maximum entry number allowed for fields of table component type is 500. 
(QCCR1L55387)

Workaround: None.

Limitation: If a user only has the access grant of a workflow step, when searching requests, the 
user cannot select the request type that uses this workflow. (QCCR1L44594)

Workaround: None.

Limitation: On the Request Search Results page, when you select several requests and click the 
Edit > Quick Edit button, you receive the following error message:

An unknown error has occurred. For more information, please contact your PPM 
administrator and provide the following GUID number...

(QCCR1L50677)

Workaround: To resolve this issue, do one of the following:

 l Select fewer requests and then click the Edit > Quick Edit button.

 l Configure as follows:

 a. Stop PPM Server.

 b. Open the <PPM_Home>/server/<PPM_Server_Name>/deploy/jbossweb-
tomcat55.sar/server.xml file, and add maxPostSize="0" right after maxThreads="150".

 c. Click Save to save your changes.

 d. Clean up the <PPM_Home>/server/<PPM_Server_Name>/tmp and the<PPM_
Home>/server/<PPM_Server_Name>/work directories.

 e. Restart PPM Server.

Limitation: PPM fails to send notifications for a workflow step, when there are many recipients 
and you configure as follows:

 1. In the Add New Recipient window of PPM Workbench, select Enter a User Defined Token.

 2. In the User Defined Token field, enter the token name of a text field.
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 3. In the Recipient Type field, select Email Address. (QCCR1L51955)

Workaround: The root cause is that for text fields, the database column used to store email 
addresses of recipients has a character limitation of 80 (including separators).

To resolve the issue, stop PPM Server and run the following SQL:

alter table knta_notif_txn_recipients modify email_address varchar(1000 CHAR);

If you encounter errors related with the KNTA_NOTIFICATION package after running the SQL, 
recompile all packages.

Limitation: When using the Request Browser to search requests (Open > Demand Management 
> Request Browser > Browse Requests), a user can select a maximum of 8 values for the Column 
Values field in the Choose Additional Column to Display in Request Browser Tree section. 
(QCCR1L51965)

Workaround: Starting from PPM version 9.22, a user can select a maximum of 12 values  for the 
Column Values field.

Problem: When sending notifications of a workflow step or request field change, PPM behaves as 
follows:

 l For recipients  who are PPM users and have already logged on to PPM at least once, PPM 
groups them together according to their user locales (user locale includes regional settings and 
display language).

 l For recipients who are not PPM users and who have  PPM user accounts but have never logged 
on to PPM, PPM groups them together.

As a result, recipients in different groups receive different notification emails.  (QCCR1L52110, 
QCCR1L52245)

Workaround: This is because only PPM users who have already logged on to PPM at least once 
have locales. To resolve this issue, do the following to define a default locale for all non-PPM 
users and PPM users who have never logged on to PPM:

 1. Set the USE_SERVER_LOCALE_FOR_NOTIFICATIONS server configuration parameter value to 
true. 

 2. Set a value for the SERVER_LOCALE_COUNTRY_CODE server configuration parameter. The 
default value is null. Valid values are any two-letter abbreviation of a country in uppercase.

For example, if you want to set the default regional settings to United States, set the SERVER_
LOCALE_COUNTRY_CODE server configuration parameter  to US.

 3. Set a value for the SERVER_LOCALE_LANGUAGE_CODE server configuration parameter. The 
default value is null. Valid values are any two-letter abbreviation of a language in lowercase.

For example, if you want to set the default display language to English, set the SERVER_
LOCALE_LANGUAGE_CODE server configuration parameter to en.
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This ensures that PPM groups all PPM users and non-PPM users together when sending 
notifications.

Problem: On the Timeout tab of the Workflow Step window in the PPM Workbench, you set a 
timeout for a workflow step to make PPM send notifications when the step gets timed out. 
However, it does not work. (QCCR1L47224)

Workaround: The root cause is that the p_step_txn_group_IN_list variable used to store step_
transaction_id has a character limitation, which can contain around 4000 transaction ids.

To solve the issue, use the following query to check if there are too many transactions pending 
notification:
select step_transaction_id FROM KWFL_PENDING_STEP_TIMEOUTS_V

If the number of returned rows exceeds 4000,  update the timeout_date column of the KWFL_
Step_Transactions table. For example, you may run the following SQL:

update KWFL_STEP_TRANSACTIONS
set TIMEOUT_DATE = sysdate +floor(rownum / 3000)
where STEP_TRANSACTION_ID　in
(select STEP_TrANSACTION_ID from KWFL_PENDING_STEP_TIMEOUTS_V)

After you run the SQL,   the timeout dates of every 3000 rows are updated in batches. The date of 
the first batch is set to the current date and is one day later every time the batch number 
increases. As a result, PPM will send notifications of 3000 transactions per day, thus avoid 
exceeding the character limitation.

Limitation: You have a request type whose Request Header Type (RHT) contains an attachment 
field. You submit a request using this request type and attach a file in the field. On the request 
details page, you change the request type to the one using a different RHT and save the change. 
If attachment fields in both target and original RHTs use the same parameter, you receive the 
following error message when clicking the link of the attached file: You do no have access to 
this page…(KNTA-11013)  

If you change the request type back to the original one, you can access the attached file again. 
(QCCR1L50552)

Workaround: None.

Limitation: PPM does not support using UI rule setFieldEditable() to set table component 
validations as editable or read-only. (QCCR1L51073)

Workaround: None.

Limitation: When there are several groups of workflow steps on the Request Details page and 
the browser cannot display all workflow steps,  the More Actions buttons appear. However, one or 
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more groups of workflow steps may disappear when you resize or restore down your browser 
window. This is because the resized browser window is not wide enough to display the More 
Actions buttons. (QCCR1L52165) 

Workaround: To resolve this issue, do one of the following:

 l Maximize your browser.

 l From the Control Panel, select a higher screen resolution.

 l Press ctrl and - to zoom out your browser.

Problem: You use a SQL rule to get a project name and display it on the Request Details page. 
When the project name contains an ampersand, the ampersand is not displayed and the name 
gets truncated on the Request Details page. (QCCR1L46993)

Workaround: PPM uses #@# as a separator. Make sure that:

 l Values used in SQL rules do not contain &amp; or #@#

 l SQL rules do not contain #@#

You can use # and @ separately.

Problem:  If the previous step is an execution step and the Processing Type is set to Immediate, 
the status dependencies, such as Clear, will not be triggered in the current step. It requires user 
interaction for these types of status dependencies (QCCR1L12363).

Workaround: None .

Limitation: PPM Center stores Request Header Type (RHT) fields in the KCRT_REQ_HEADER_
DETAILS table, which has only 50 columns available. (QCCR1L13835)

Workaround: None.

Problem: If a request contains a rule that uses KNTA_MULTI.Find_User_full_ names([SYS.USER_
ID]) from sys.dual, saving the request may fail or removing associated entities from the request 
may fail.

Workaround: Use KNTA_MULTI.Find_UserNames([SYS.USER_ID]) from sys.dual instead.

Limitation: When Text Field is set to “is equal to” the value of an Auto Complete List or Drop 
Down List value in the Dependencies section of the Rules tab in the request type workbench, the 
dependencies do not work; However, if the Text Field is set to match the code of the Auto 
Complete List or Drop Down List, the dependencies work well. (QCCR1L27020)

Workaround: Considering the fact that Auto Complete List and/or Drop Down List values can be 
localized, which will then cause consistency issue for the dependencies, PPM recommends you 
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match Text Field code to the code of Auto Complete List or Drop Down List when you set up 
request type field dependencies.

Limitation: A token unparseable error occurs when creating a request of a request type, where 
its validation referenced a non-existing token. (QCCR1L27418)

Workaround: When you specify a validation for your request type, report type, or object type, 
make sure that the token(s) referenced by the validation already exist.

Limitation: If you have included too many items in the Request Type field or the Selected 
Columns list on the Search Requests page, an error might occur when you try to save your search 
preferences. (QCCR1L39090, QCCR1L47244)

Workaround: Do not include too many items in the Request Types field or the Selected Columns 
list on the Search Requests page. For better performance, PPM recommends that you limit the 
total size of the Request Types field and the Selected Columns list to 1500 characters.

Limitation:  When applying advanced rules on requests with "Printable Version" and the Print 
function, the previewed and printed data does not match with what is displayed on the screen. 
(QCCR1L39873)

Workaround: Now rules can be executed on the printable version of Request Details, but with 
the following limitations:

 l Only SQL rules and UI Rule setFieldVisible()will be executed.

 l Only Apply on page load rule event is supported.

 l The printable version should be opened from Request Details page instead of by entering the 
URL address directly.

Limitation: If a field is set to “Display = No" or invisible by status dependency, you can not make it 
visible on the web UI by using UI rules. (QCCR1L40010)

Workaround: None.

Limitation:  SQL for Hierarchical Display (tree validation) now supports resolving such static 
tokens as [SYS.USERNAME] and [SYS.USER_ID].

Other types of tokens, such as Request Details or Context related tokens, are not supported. 
(QCCR1L40379)

Workaround: None.

Limitation: Auto-complete component's valid value list is not in client UI, so when using rule to 
set values for auto-complete component, the values are not validated and invalid values can be 
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set. As a result, when users create a request, a value that is not in auto-complete list can be 
inserted and saved in an auto-complete field as triggered by the SQL rule. (QCCR1L41050)

Workaround: PPM administrators who configure SQL rules to set values for auto-complete list 
should make sure that only valid values are set.

Problem: After you enable field group Program Issue: Allows Requests to be considered as 
Issues In a Program for a request header type, no Program Issue section is added to the Fields tab 
of the request header type.(QCCR1L41722)

Workaround: This behavior is by design and it has no functional impact. Request types using this 
request header type can still be used as program issue type and it works fine for program issue 
tracking.

Limitation: Rule dependency is not supported if the dependency field is using the () pattern to 
present negative numbers. For example, using (1000) to represent -1000. (QCCR1L42478)

Workaround: None.

Problem: An error occurs when performing Quick Edit or Mass Update on requests of non-PFM-
Proposal request types that use PFM - Finish Period by Month validation. This is because the 
PFM - Finish Period by Month validation requires a field with token KNTA_PLAN_START_DATE 
for the SQL to be executed, while for most of non-PFM-Proposal request types, there is no such 
field. (QCCR1L43340)

Workaround: Do not use PFM - Finish Period by Month validation for non-PFM-Proposal 
request types.

Limitation: When using a jump/receive workflow, you add a new package line to a package after 
you have submitted all the package lines and started the package workflow for any one of them. 
As a result, the package and the request are not in synchronization. (QCCR1L45417)

Workaround: Add all package lines before you start the package workflow for any one of them.

Problem: (Sun Solaris only) You submit a request using the workflow whose initial step is an 
execution workflow step. The workflow cannot proceed to the next step and you see an error 
message similar to the follows on the Request Execution Log page:

The attachment file could not be downloaded. The file: REQ_

XXXX/REQ_XXXX_BID_XXXXX.html no longer exists on the server…

This is due to a system limitation with Sun Solaris that one directory can only contain 32k 32768 
sub-directories (maybe 64k 65536 in some versions). When PPM workflow in a request execute a 
command, it creates a folder for each request to log the execution information, so it may exceed 
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the limitation if there are many requests that will execute a command in workflows. 
(QCCR1L47984)

Workaround: A task is added to the Directory Cleanup Service to delete the request log files 
periodically. The default value of the WEB_FILE_CACHE_LIFETIME_IN_DAYS server 
configuration parameter is 7. Therefore, request log files created 7 days ago are deleted. You can 
increase or decrease the server configuration parameter value as needed.

Problem: When a request is created in a non-English-speaking region with a regional language 
other than English, users cannot receive email approval notifications. (QCCR1L48350)

Workaround: Install Multilingual User Interface (MLU) in PPM Center.

Problem: There is only one request on the last page of the Request List portlet on the Dashboard 
page. You open the request and cancel it. When you go back to the Dashboard page, you see no 
results from the Request List portlet. The portlet works again if you reopen the Dashboard page. 
(QCCR1L48445)

Workaround: None.

Deployment Management

Problem: Transfer of bundle to Destination environment fails as the ksc_copy command is not 
working for the Request Type Migrator. (QCCR1L40858)

Workaround: Set variable DISABLE_SCP_FILENAME_QUOTE in the Environment User Data.

Problem: File transfer from source environment to destination environment using Reflection for 
Secure IT for Unix (version 7.1) server fails when the environments were configured in a workflow 
execution step. (QCCR1L24976)

Workaround: To use Reflection for Secure IT for Unix server to transfer files successfully,

 1. Create a new Environment User Data using the following values:

 l Field Prompt: DISABLE_SCP_FILENAME_QUOTE

 l Token: DISABLE_SCP_FILENAME_QUOTE

 l Enabled: Yes

 l Validation: Yes No Radio Buttons

 l User Data Column: Select a value from the drop down list.

 l Display: Yes

 l Display Only: Never

 l Required: Never
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Then, in the Environment you want to use, enable the newly created user data.

For more information about creating and enabling user data, see the HP Deployment 
Management Configuration Guide.

 2. Note down the Server environment and Client environment values you used in step 

 3. Configure the workflow execution step and use the Server environment and Client 
environment values you noted down earlier for Source Environment and Dest Environment 
fields.

Problem: If you used environment tokens in Object Type with special command ksc_copy_server_
server and set the Source and Destination environments as its arameters, file transfer from source 
environment to destination environment with Reflection for Secure IT for Unix (version 7.1) 
server fails. (QCCR1L27758)

Workaround: Modify the environment settings by following the instructions described in the 
WORKAROUND for QCCR1L24976.

Financial Management

Limitation: A resource is assigned to a position. When the resource's full name is changed, the 
change is reflected in the Staffing Profile page, but not reflected in the Resource Forecast Cost 
chart of the Cost tab on the Project Overview page. (QCCR1L56260) 

Workaround: None.

Limitation: When you set a task as a milestone, the schedule duration and schedule effort change 
to 0. After the Cost Rollup Service is run, the planned labor cost becomes 0, however, the EVM 
data keeps the old values. (QCCR1L55619) 

Workaround: None.

Portfolio Management

Limitation: The COST_CAPITALIZATION_ENABLED server.conf parameter cannot be changed 
using the Administration Console. (QCCR1L41323)

Workaround: The flag can be changed directly in the server.conf parameters as needed. 
However, PPM strongly recommends not disabling cost capitalization if it has been enabled.

Problem: Transaction History and Notes History cannot be enabled in the Associated Programs 
field of a PFM - Asset, PFM - Project, or PFM - Proposal request header type or a copy of one of 
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these request header types. Selecting Yes or No does not enable these auditing features. 
(QCCR1L26865)

Workaround: None.

Project Management

Limitation: If you use Firefox browser and click Modify Search on the Add 
Projects/Tasks/Requests/Packages to Time Sheet window, the previously provided search criteria 
are wiped out. (QCCR1L53555, QCCR1L53570)

Workaround: Use Internet Explorer browser instead, or complete the filter fields again in Firefox 
browser.

Problem: When exporting a financial summary to an Excel file, the data format in Excel differs 
from that in PPM Center. (QCCR1L44632)

Workaround: Change the regional settings of your operating system from the Control Panel, so 
that they are the same as your current regional settings set on the Regional Settings tab of the 
Edit My Profile page (Open > Administration > Edit My Profile > Regional Settings).

Problem: When exporting a work plan to both PDF and Excel, if the work plan has a task with a 
name that contains double-byte numbers, the exported PDF differs from the exported Excel. In 
the exported PDF, the task name does not contain the double-byte numbers. (QCCR1L14109)

Workaround: None.

Problem: If a user edits a task’s external predecessor from the work plan page, when the task is 
saved, the external predecessor is deleted. (QCCR1L27616)

Workaround: Use the Task Details page to edit a task’s external predecessors. Do not edit 
external predecessors from the work plan page.

Problem:When installing the Plug-in for PPM for all users, the installation finishes but the HP 
PPM Center menu is not visible in Microsoft Project. This is because Microsoft Office 2007 Hotfix 
976811 only supports operating systems Windows Vista and Windows XP. (QCCR1L39188)

Workaround: Install the Plug-in for PPM for current user only.

Problem: When exporting a financial summary to an Excel file, the data format in Excel differs 
from that in PPM Center. (QCCR1L44632)
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Workaround: Change the regional settings of your operating system from the Control Panel, so 
that they are the same as your current regional settings set on the Regional Settings tab of the 
Edit My Profile page (Open > Administration > Edit My Profile > Regional Settings).

Problem:  When the structure of a work plan has been changed, the values for Planned Value, 
Earned Value, CPI, and SPI become 0 after the Cost Rollup Service runs. (QCCR1L56155, 
QCCR1L55737)

Workaround: To obtain values for Planned Value, Earned Value, CPI, and SPI for earned value 
analysis purpose, after any work plan structure change, recreate a new baseline for your project.

Problem: On the Cost tab of the Project Overview page, when you adjust the scope in the Earned 
Value Analysis view to model impact to the project, the diagram in the Earned Value Analysis chart 
may display out of the frame if the EACT value covers months earlier than the starting month on 
X-axis. (QCCR1L55862)

Workaround: None.

Integrations - Quality Center (ALM)

Limitation: If you provide a value for the QC/ALM Synchronization Control field, this value is the 
field in ALM that controls whether the QC/ALM end users want to create a defect in PPM Center 
as a result of creating a defect in ALM. However, if you set this field in ALM as a required field, 
errors appear no matter whether or not you build field mapping for this field. (QCCR1L56956) 

Workaround: Do not set the field selected in the QC/ALM Synchronization Control field as 
required in ALM.

Limitation: Integration fails when QC/ALM project names contain non-Latin characters (for 
example, Russian). (QCCR1L47799)

Workaround: Use Latin characters only for QC/ALM project names. The QC/ALM RESTful API 
does not support non-Latin characters.

Problem: (Integration with Quality Center version 10.00 only) After upgrading PPM Center, if 
you reload the “QC/ALM Defect Information” field group (it is Quality Center Defect Information 
in PPM Center version 9.14 or earlier) in a Request Header Type of a request type (by unchecking 
the field group first and then checking it again), and create a defect in Quality Center to create a 
new request in PPM Center, errors may occur. (QCCR1L46633)

Workaround: Modify the Request Header Type by restoring the layout of the field group fields 
on the Layout tab to the default. For example, make sure that QC/ALM Instance the first field, 
QC/ALM Domain the second, QC/ALM Project the third, and so on.
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Limitation: Cannot synchronize status of defects or requirements from Quality Center 10.00 or 
HP ALM 11.x when the value of the status in QC or ALM is in a non-English language, for 
example, Chinese. (QCCR1L47995)

Workaround: None.

Integrations - View Project Quality

Problem: (IE only) When adding an integration configuration on the View Project Quality 
integration landing page, entering a long name in the QC/ALM Server Name field may cause 
display alignment issue with the list of View Project Quality integration configurations.

Workaround: Enter a shorter name instead.

Limitation: When mapping a PPM task to an ALM release, if the values in the target HP ALM 
server are in German or Korean, after you added a filter and specified an ALM Criteria, and then 
clicked the selector icon for Criteria Value, the available values retrieved by ALM REST API from 
ALM may display as garbled characters in the pop-up window, for example, "???".

Workaround: None.

Limitation: When mapping a PPM task to an ALM release and adding filters, some invisible fields 
in ALM are also retrieved by the ALM REST API and are displayed in the ALM Criteria column on 
the Quality tab of the Task Details page. Such invisible fields include: 

 l For Defect: To Mail

 l For Requirement: Some fields that start with RBQM.

Workaround: None.

Problem: When mapping a PPM task to an ALM release and adding filters, though the Subject 
field value is empty in the Criteria Value column on  the Quality tab of the Task Details page, the  
ALM REST APIs get test plan folder name as available values for this field from ALM.

Workaround: None.

Integrations - Universal CMDB

Problem: (PPM version 9.20 and later) When you integrate PPM with Universal CMDB for impact 
analysis, the ";" character is not supported. If a UCMDB CI name contains a ";" character, it would 
be treated as a separator and two entries would show up in the Impacted Configuration Items 
section of the PPM request after you loaded selected CIs into the request. (QCCR1L52964)

Workaround: None.
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Integrations - Agile Manager

Limitation: If you indent or outdent unmapped tasks to make them become the leaf tasks of the 
tasks mapped with waterfall projects or agile projects, the unmapped tasks may be deleted after 
synchronization. (QCCR1L55750)

Workaround: PPM Recommend that you do not indent or outdent unmapped tasks to make 
them become the leaf tasks of the tasks mapped with waterfall projects or agile projects.

Integrations - Service Manager

Problem: If you are PPM 9.40 fresh user, when you select the Create an Operational Request for 
Change (RFC) upon task save check box in the Operational RFC tab on the Task Details page and 
click Save or Done, the check box is unselected after you refresh the page. (QCCR1L62789)

Workaround: You can either wait for the patch release on top of PPM 9.40 where this issue is 
fixed or run the following SQL:

CREATE SEQUENCE SM_RFC_S INCREMENT BY 1
 MINVALUE 1 MAXVALUE 999999999999999999999999999 START WITH 30000
 CACHE 20 NOORDER NOCYCLE;

commit;

Installation

Limitation: If Windows system language is Chinese, Japanese, or Korean, and the system has JDK 
8 installed, PPM installer wizard does not display language list where you can select one for the 
installation steps. (QCCR1L62233)

Workaround: This is the limitation of the third-party software InstallAnywhere. To work around 
this issue, run the following command  to set the locale for the PPM installer wizard:

sh install.sh -l <language_code>

where language codes for Chinese, Japanese, and Korean are zh_CN, ja, and ko respectively.

Limitation: (AIX system only) When you perform upgrade on AIX system, if you choose a 
double-type language (for example, Simplified Chinese, Korean, or Japanese), and you use 
MobaXterm as client side tool to connect to AIX, you may experience the issue that some labels 
names are not shown as well as an upgrade error.(QCCR1L49613)
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Workaround: To resolve the issue, clear data from the KINS_ACTIONS table, and retry the step 
where you got an upgrade error earlier.

iPad Certification

Problem: In the My Tasks portlet on the PPM Dashboard page, after you click Edit Effort 
Breakdown, input fields in the pop-up window are too narrow to display the inputted data.

Workaround: None.

Problem: You cannot click the column headings to change the sort order of the table on the 
following pages:

 l The Subportfolios, Programs, and Proposal/Project/Asset tabs of the View Portfolio page

 l The Scenario Content section of the Scenario Comparison page.

Workaround: None.

Limitation: After you add a reference in the References section of the Program Overview page or 
on the References tab of the Task Details page, the newly added reference is not displayed in the 
References to be added on Save field. (QCCR1L49441)

Workaround: None.

Problem: The View Work Plan page and the Project Settings page may not work properly. For 
example, when you click the Name or the Predecessors column on the View Work Plan page, the 
work plan gets truncated.

Workaround: HPE recommends that you perform such actions on your computer.

Problem: You cannot perform any action on the Administration Console page.

Workaround: None.

Problem: You cannot use features related to right-clicking on PPM pages. This is because iPad 
does not support right-clicking.

Workaround: None.

Problem: You may encounter style problems when using PPM. For example, table on the Manage 
Resource Pool page exceeds the right boarder of the page.

Workaround: None.
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Problem: You cannot export PPM pages to PDF/EXCEL files.

Workaround: None.

Limitation: You cannot see tooltips on PPM pages. This is because Apple Safari in mobile devices 
does not support Alt/Title attribute.

Workaround: None.

Limitation: (Apple IOS 5.0 only) You cannot upload files on PPM pages, this is because Apple 
IOS 5.0 does not support uploading files.

Workaround: None.

Limitation: Due to iPad limitations, you cannot use features utilizing Microsoft Silverlight, or 
download/upload EXCEL files in Application Portfolio Management.

Workaround: None.

Multilingual User Interface (MLU)

Limitation: The Arabic language is not available in the PPM upgrade wizard. (QCCR1L55950)

Workaround: None.

Limitation: You can not save scenarios with special characters, such as Chinese characters.  
(QCCR1L55863)

Workaround: None.

Problem: When deploying language packs, the logs will show the following error for all 
languages, except for the system language:

[java] java.sql.SQLIntegrityConstraintViolationException:
 ORA-02291: Integrity-Constraint (GEEK_01.KNTA_NOTIFICATIONS_ LOC_FK) violated 

This error has no functional impact. (QCCR1L27539).

Workaround: None.

Problem: When installing PPM on a localized (for example, Swedish) Windows platform, at the 
MLU step of the installer wizard, English and the language of the system (in this case, Swedish) 
are selected by default. When you launch PPM after the installation, only English language is 
available in the Language drop-down list on the PPM logon page. The default selected language 
of the system was not installed. 
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If, at the MLU step of the installer wizard, you select a third language (say, Korean) in addition to 
English and the language of the system (in this case, Swedish) which are selected by default. 
When you launch PPM after the installation, only English and the third language (in this case, 
Korean) you selected during the installation are available in the Language drop-down list on the 
PPM logon page. The default selected language of the system was not installed.

(QCCR1L55604)

Workaround: After the installation of PPM instance, run the kDeploy script as follows to 
redeploy the desired language pack: 

sh ./kDeploy.sh -lang <locale>

In this case, run the following to deploy the Swedish language pack: 
sh ./kDeploy.sh -lang sv

Problem: Some language names still display in English instead of in Arabic at the MLU step of the 
Install Wizard during PPM server installation for Arabic.  (QCCR1L55838)

Workaround: None.

Limitation: PPM can not display Arabic strings properly in the following situations:

 l After applying the Arabic language pack, on some pages (for example, the Request Search 
Result page and the Project Overview page), PPM could not display Arabic strings properly if 
the strings (say, project names) contain any of the following combinations: 

 l Number + Arabic + non-Arabic language (with or without space)

 l Number + Arabic + Number (with or without space)

 l Non-Arabic language + Arabic + Number (with or without space)

 l Arabic + non-Arabic language +Number (with or without space)

 l Arabic + Number + non-Arabic language (with or without space)

The Arabic word is always moved to the right side in the output display. (QCCR1L54179, 
QCCR1L54453, QCCR1L54300, QCCR1L54292, QCCR1L54519, QCCR1L54258)

 l Left alignment issue of UI elements. PPM UI elements are still left-aligned after applying the 
Arabic language pack.

 l Hard-coded UI elements display issue. If a PPM page contains hard-coded UI elements (for 
example, punctuation symbols like full stop and comma, and Yes/No radio buttons), there are 
display issues when the page is accessed in Arabic language:

 l Full stop and comma display issue. The locations for full stop and comma are hard-coded, 
therefore you see them stay where they are even after applying the Arabic language pack. 
For example, the full stop stays at the beginning  of an Arabic sentence, instead of moving to 
the left end, which is the correct location for the full stop.
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 l Radio buttons display issue. The layout of the radio buttons with Arabic translations on the 
page look confusing. (QCCR1L54181, QCCR1L54319)

 l Parentheses display issue. When an Arabic string contains parentheses, that is, "(" and ")", PPM 
can not display the string properly. (QCCR1L54259, QCCR1L54518)

Workaround: None.

Problem: A JavaScript error message (Errors on this webpage might cause it to work 
incorrectly) pops up in the following scenarios: 

 l Loging in to PPM

 l Loading PPM Dashboard

 l Opening the Project Overview page

 l Deleting a request

 l Opening or customizing a portlet

Workaround: You can click Close in the message window to safely ignore the Java script error. No 
functional impact found so far.

Limitation: PPM does not support lunar calendars, therefore you cannot find Islamic (or Hijri) 
calendar for Arabic countries. (QCCR1L54422)

Workaround: None.

Problem:  The Done icon is truncated on Arabic PPM Center pages. (QCCR1L54321, 
QCCR1L54271)

Workaround: None.

Problem:  When creating an entity (say, a request) without filling all required fields, links to 
required fields are missing from the warning message that displays when you save the entity. 

Workaround: None.

Problem:  After exporting a page or a portlet to PDF in Arabic session, the exported PDF file is 
almost empty, it cannot display Arabic strings.

Workaround: None.

Platform

Problem:  In PPM Workbench, the changes made to a user in one language are not maintained in 
another language. (QCCR1L62003) 
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Workaround: None.

Limitation: When PPM Workbench communicates with PPM Server via HTTP(S) and PPM is run 
in the SSO mode, you can only open workbench in Internet Explorer using the PPM menu Open > 
Administration > Open Workbench. (QCCR1L60749) 

Workaround: None.

Limitation: If you install language packs after the fresh installation of PPM Center or the upgrade 
to PPM Center, some strings on the Submit Report page may not be translated. (QCCR1L56840) 
Workaround: None.

Limitation: Error appears if you use NT Service on Windows platform to restart PPM Server. 

Workaround: If you want to restart PPM Server with NT Service, do the following: 

 1. Click the Stop button to stop PPM Server. 

 2. Run the kStatus.sh script to check and make sure PPM Server is stopped. 

 3. Click the Start button to restart PPM Server.

Problem: In previous versions, if no port number is specified for LDAP server URL, the default 
port number 389 is used. In version 9.30, an error occurs if no port number is specified for LDAP 
server URL, even when you use SSL-enabled LDAP server. (QCCR1L56232).

Workaround: Add the port number 389 in the LDAP URL if you use the default port number, no 
matter whether or not you use SSL-enabled LDAP server.

Limitation: For the drop-down list validations that are used in workflow steps, PPM Center does 
not deal with tokens with the prefix REQ, REQD, or WF. (QCCR1L53969).

Workaround: None.

Limitation:When there is no shared folder in a cluster for the server.conf file, changes made to 
the server configuration parameters through Admin Console when logged into a specific node in 
the cluster are not propagated to the server.conf file in other nodes. (QCCR1L45580)

Workaround: There are two workarounds:

 l Make sure you make changes to server configuration parameters for each node in the cluster 
manually. Or,

 l Create a shared folder for the server.conf file to give all nodes in the cluster access to the 
same server.conf file.
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Limitation: You may encounter an error when opening a subworkflow in Graphical View: 
java.io.IOException: too many colors for a GIF (QCCR1L48353)

Workaround: Do the following:

 1. Set the com.kintana.core.server.LOW_COLOR_WF_IMAGE parameter to true in server.conf.

 2. Go to the <PPM_Home>/bin directory and run the following command: 

sh ./kUpdateHtml.sh

 3. Restart PPM server.

Problem: (Non-Windows platforms) When a non-root user starts PPM Server on a non-Windows 
platform, some warning messages may pop up. (QCCR1L55730)

Workaround: Simply ignore these warning messages as they have no impact to the system.

Resource Management

Problem: When the number of resources is greater than 1000 on the Resource Usage page, the 
performance is not desirable when you open the page from the work plan. (QCCR1L56507) 
Workaround: You can use the Analyze Assignment Load portlet if there are large number of 
resources in one work plan.

Limitation: If you select a resource pool and time periods in the Gantt view of the Resource 
Allocation Management page, and then refresh the page, your selected resource pool and time 
periods disappear. (QCCR1L56573)

Workaround: Go to the Table view of the Resource Allocation Management page if you want to 
refresh the page after selecting the resource pool and time periods.

Problem: Data display format inconsistency between the staffing profile page and the Analyze 
Assignment Load portlet: the staffing profile page displays data by hours in the format of one 
decimal place, while the Analyze Assignment Load portlet displays data in the format of two 
decimal places.

Workaround: None.

Time Management

Problem: You may get the following session error while trying to open a time sheet using the 
hyperlink on the spreadsheet created from the Approve Time Sheet portlet.
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Your session has timed out due to inactivity. Any unsaved changes have been lost. 
Please reload the Time Sheet to continue with your changes.

(QCCR1L45610)

Workaround: To fix the issue, use the workaround provided by Microsoft: 
http://support.microsoft.com/kb/218153

PPM Workbench

Problem: You cannot open PPM Workbench in Google Chrome through the Open > 
Administration > Open Workbench menu as a result of NPAPI deprecation.

Workaround: Open PPM Workbench in Google Chrome through the menu Open > Administration 
> Open Workbench on Desktop.

Problem: You may experience problem when trying to export large workflow diagram from PPM 
Workbench.

Workaround: If you open PPM Workbench by clicking Open > Administration > Open 
Workbench, you may need to increase your heap size from Java Plug-in in order to export large 
workflow diagram from PPM Workbench.

To do so,

 1. On Windows platform, click Start > Control Panel > Java Plug-in.

 2. In the Java Control Panel dialog, select the Java tab, and click View under Java Applet 
Runtime Settings.

 3. Find the most recent Version Java runtime line, double click in the Java Runtime Parameters 
field and add -Xmx<heap_size>m. <heap_size> shall be a number appropriate to your 
system. For example, -Xmx300m, that is, setting Java maximum heap size to 300 MB.

 4. Click OK.

Note: Make sure you exit all web browser windows.

Limitation: When users open PPM Workbench in 64-bit Internet Explorer by clicking Open > 
Administration > Open Workbench, they are prompted to install Java plug-in 1.7.0. After 
installing the Java Plug-in by following the screen instructions, they still receive prompt asking 
them to install Java plug-in 1.7.0.

Workaround: Oracle provides automatic installation kit for 32-bit Java Plug-in 1.7.0 only. To 
install the 64-bit Java plug-in 1.7.0, go to Oracle website, manually download and install the 64-bit 
Java plug-in 1.7.0.
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Problem: PPM Workbench cannot open after installing JRE7u25. This is caused by change in 
Java applet made by Oracle with the latest Java plug-in. For more details, see 
http://www.oracle.com/technetwork/java/javase/7u25-relnotes-1955741.html. (QCCR1L52313) 

Workaround 1: Uninstall JRE7u25, then reinstall and use JRE7u11.

The latest Java plug-in causes the issue with the PPM Workbench, therefore it is recommended to 
use JRE7u11.

Workaround 2: Clear Java cache settings and disable certificate revocation checking. To do so,

 1. Go to Start > Control Panel > Java. 

The Java Control Panel window opens.

 2. Clear Java cache settings. 

 a. On  the General tab, click Settings in the Temporary Internet Files section. The Temporary 
Files Settings dialog opens.

 b. Click Delete Files.The Delete Files and Applications dialog opens.

 c. Select Cached Applications and Applets and click OK.

 3. Disable certificate revocation checking. 

 a. Go to the Advanced tab of the Java Control Panel window. 

 b. Expand Security > General, uncheck the Check certificates for revocation using 
Certificate Revocation Lists (CRLs) option, and click OK.

 4. Open the PPM Workbench again.

Caution: Disabling on line revocation checking should only be considered in managed 
environments as it decreases security protections.

User Management

Problem: If a user's name exceeds 100 characters, you cannot edit the user as the edit icon is 
blocked by the user's name.

Workaround: None.

Release Notes
Known Problems and Limitations

HPE Project and Portfolio Management (9.40) Page 56 of 58

http://www.oracle.com/technetwork/java/javase/7u25-relnotes-1955741.html


Documentation Errata
The following documentation items are incorrect.

Installation and Administration Guide

Incorrect description of PORTLET_MONITOR_PERSIST_STATE

Location: Installation and Administration Guide, version 9.30

Error: The description of the parameter PORTLET_MONITOR_PERSIST_STATE is incorrect in 
the guide. 

Correction:  Update the description of the parameter as follows:

If the parameter PORTLET_MONITOR_PERSIST_STATE is set to true, portlet monitor logs 
portlet load information in the table PPM_PERFORMANCE_LOG.

Document Management Guide and Reference

Incorrect description of  DMS_INSECURE_FILE_EXTENSION_CHECK and DMS_INSECURE_
FILE_EXTENSIONS

Location: Document Management Guide and Reference, version 9.30

Error: The descriptions about DMS_INSECURE_FILE_EXTENSION_CHECK and DMS_
INSECURE_FILE_EXTENSIONS are misleading. It gives users an impression that only executable 
file extensions can be added to parameter DMS_INSECURE_FILE_EXTENSIONS, but actually any 
file extensions can be added to DMS_INSECURE_FILE_EXTENSIONS. 

Correction:  Update the descriptions of the parameters as follows:

DMS_INSECURE_FILE_EXTENSION_CHECK: If set to true, it prevents uploading files of the 
extensions defined in the DMS_INSECURE_FILE_EXTENDSIONS parameter. For example, if the 
value of  the DMS_INSECURE_FILE_EXTENDSIONS parameter is 
exe,com,bat,reg,jar,cmd,lnk,htm,html,js, you cannot upload files of these extensions to 
PPM.
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Send Us Feedback
Let us know how we can improve your experience with the Release Notes.

Send your email to: docteam@hpe.com
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